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Object of Declaration: HV9963 Boost LED Driver Demonstration Board

EU Declaration of Conformity

Manufacturer: Microchip Technology Inc.
2355 W. Chandler Blvd.
Chandler, Arizona, 85224-56199
USA

This declaration of conformity is issued by the manufacturer.

The development/evaluation tool is designed to be used for research and development in a laboratory
environment. This development/fevaluation tool is not a Finished Appliance, nor is it intended for
incorporation into Finished Appliances that are made commercially available as single functional units to
end users under EU EMC Directive 2004/108/EC and as supported by the European Commission’s Guide
for the EMC Directive 2004/108/EC (8" February 2010).

This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU.

This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in
compliance with the essential requirement and other relevant provisions of the R&TTE Directive
1999/5/EC and the FCC rules as stated in the declaration of conformity provided in the module
datasheet and the module product page available at www.microchip.com.

For information regarding the exclusive, limited warranties applicable to Microchip products, please see
Microchip’s standard terms and conditions of sale, which are printed on our sales documentation and
available at www._microchip.com.

Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA

(E~Sep - tY
Derek Carlson ' Date
VP Development Tools
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Preface

NOTICE TO CUSTOMERS

of the document.

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our website
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXXXXA”, where “ XXXXXXXX" is the document number and “A” is the revision level

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
HV9963 Boost LED Driver Demonstration Board. Items discussed in this chapter
include:

Document Layout

Conventions Used in this Guide
Recommended Reading

The Microchip Website
Customer Support

Document Revision History

DOCUMENT LAYOUT
This document describes how to use the HV9963 Boost LED Driver Demonstration
Board as a development tool to emulate and debug firmware on a target board. The
manual layout is as follows:

Chapter 1. “Product Overview” — Important information about the HV9963
Boost LED Driver Demonstration Board.

Chapter 2. “Installation and Operation” — This chapter includes a detailed
description of each function of the demonstration board and instructions for how to
use the board.

Appendix A. “Schematic and Layouts” — Shows the schematic and layout
diagrams for the HV9963 Boost LED Driver Demonstration Board.
Appendix B. “Bill of Materials (BOM)” — Lists the parts used to build the
HV9963 Boost LED Driver Demonstration Board.

Appendix C. “Plots and Waveforms” — Describes the various plots and
waveforms for the HV9963 Boost LED Driver Demonstration Board.

© 2016 Microchip Technology Inc. DS50002453A-page 7
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User'’s Guide

Emphasized text

...Is the only compiler...

Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”
dialog
Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris the radix and nis a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#defi ne START

Filenames aut oexec. bat

File paths c:\nctcl8\h

Keywords _asm _endasm static
Command-line options - Qpa+, -Opa-

Bit values 0, 1

Constants OxFF, ‘A

Italic Courier New

A variable argument

file.o,wherefilecanbe
any valid filename

Square brackets [ ]

Optional arguments

nccl8 [options] file
[opti ons]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var _name [,
var _nane. . .|

Represents code supplied by
user

void main (void)
{
}

DS50002453A-page 8
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Preface

RECOMMENDED READING

This user’s guide describes how to use the HV9963 Boost LED Driver Demonstration
Board. Another useful document is listed below. The following Microchip document is
available and recommended as a supplemental reference resource:

* HV9963 Data Sheet —“Closed Loop LED Driver with Enhanced PWM
Dimming” (DSFP-HV9963).

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website

is used as a means to make files and information easily available to customers. Acces-

sible by using your favorite Internet browser, the website contains the following infor-

mation:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

* Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

+ Distributor or Representative

* Local Sales Office

* Field Application Engineer (FAE)
 Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the website at:
http://www.microchip.com/support

DOCUMENT REVISION HISTORY

Revision A (January 2016)

« Initial Release of this Document.

© 2016 Microchip Technology Inc. DS50002453A-page 9
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HV9963 BOOST LED DRIVER
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MICROCHIP USER’S GUIDE
Chapter 1. Product Overview

1.1 INTRODUCTION

This chapter provides an overview of the HV9963 Boost LED Driver Demonstration
Board and covers the following topics:

* HV9963 Device Short Overview

* What is the HV9963 Boost LED Driver Demonstration Board?

* HV9963 Device Features

* HV9963 Boost LED Driver Demonstration Board Technical Specifications
» Functional Description

* What the HVY9963 Boost LED Driver Demonstration Board User’s Guide Kit
Contains

1.2 HV9963 DEVICE SHORT OVERVIEW

The HV9963 is a current mode control LED driver IC designed to control single switch PWM
converters (buck, boost, buck-boost or Single-Ended Primary Inductor Converter - SEPIC)
in a constant frequency mode. The controller uses a peak current-mode control scheme
(with programmable slope compensation) and includes an internal transconductance
amplifier to accurately control the output current over all line and load conditions.
Multiple HV9963s can be synchronized to each other or to an external clock using the
SYNC pin.

The IC also provides a disconnect switch gate drive output, which can be used to
disconnect the LEDs in case of a fault condition using an external disconnect FET. The
10V external FET drivers allow the use of standard level FETs. The low voltage 5.0V
AVpp is used to power the internal logic and also acts as a reference voltage to set the
current level. The HV9963 includes an enhanced PWM dimming logic (patented) that
enables very high PWM dimming ratios. The HV9963 also provides a TTL-compatible,
low-frequency PWM dimming input that can accept an external control signal with a
duty ratio of 0-100% and a frequency of up to a few tens of kilohertz.

1.3 WHAT IS THE HV9963 BOOST LED DRIVER DEMONSTRATION BOARD?

The HV9963 Boost LED Driver Demonstration Board is a Boost Mode LED Driver
capable of driving up to 20 one-watt LEDs in series from an input of 22V - 26V DC. It
uses the Microchip Technology Inc. HV9963 device in a boost topology. The converter
has very good initial regulation (+/-5%) and excellent line and load regulation over the
entire input and output voltage range (< +/-1%). The full load efficiency of the converter
is typically greater than 90%.

The HV9963 Boost LED Driver Demonstration Board is protected against open-LED
and output short circuit conditions. It is also protected from input undervoltage
conditions by limiting the input current. It has excellent pulse-width modulation (PWM)
dimming response, with typical rise and fall times less than 1.0 ys, which allows very
high PWM dimming ratios. The switching frequency of the HV9963 can be
synchronized to other HV9963 boards or to an external 200 kHz clock by connecting
the clock to the SYNC pin of the HV9963 demo board.

© 2016 Microchip Technology Inc. DS50002453A-page 11
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The HV9963 Boost LED Driver Demonstration Board features Hiccup-mode short
circuit and open-LED protection. Upon detection of either fault condition, the IC shuts
down the driver and periodically attempts to restart until the fault condition ends. The
board also features a built-in 500 ns blanking to prevent false tripping of the overcurrent
comparator due to parasitic capacitance spikes during PWM dimming.

Note: This application uses a Peak Current Mode Control. Use only the HV9963
device option for this board.

CONNECTION DIAGRAM

DRA127
101

11CH14C /
&

&

+
22V - 26V,
DC
-
N | AR\ MicRocHIP
O |
N Blavor | BEDRRER
| 4
1noO

1.4 HV9963 DEVICE FEATURES

» Switch Mode controller for single-switch converters (Buck, Boost, Buck-Boost and
SEPIC)

 High output current accuracy

» High PWM dimming ratio (more than 5000:1)

* Internal 40V linear regulator

* Internal £2% voltage reference

» Constant frequency operation with synchronization capability

» Programmable soft start

* 10V GATE drivers

» Hiccup-mode protection for both short-circuit and open-circuit conditions

DS50002453A-page 12 © 2016 Microchip Technology Inc.
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1.5 HV9963 BOOST LED DRIVER DEMONSTRATION BOARD TECHNICAL
SPECIFICATIONS

» Mode of Operation: Continuous Conduction Mode
* Input Voltage (steady state): 22V - 26V DC

» Output LED String Voltage: 40V - 75V maximum
* Output Current: 350 mA +/-5%

» Output Current Ripple: 6.5% Typical

» Switching Frequency: 200 kHz

* Full-Load Efficiency: 93% (at 24V Input)

* Open-LED Protection: Shuts Down at 86.4V

» Output Short Circuit Protection: Included

* Input Undervoltage Protection: Included

*« PWM Dimming: 1:5000 Dimming Ratio at 200 Hz

Figure 1-1 shows a simplified block diagram of the application.

NI
1%
D, (optional)
;
Vin o ﬂ DN
2 Rer O
OVP1
——Cn B [ \\4
:[ RCS; Rovpz =
- c
PVDDT — CSC '
= = \
Q, Y
PVDD GT CSs OVP '_
V
IN FL |,—<
T
HV9963
PWM | PWMD FB ng
Dimming
Input
GND Irer 1
HCP SYNC SS COMP RT Avbp
= —VV\
R
REF1 RREF2§
== Chcp ==Css T Ce RT§ = Cavop
FIGURE 1-1: HV9963 Boost LED Driver Demonstration Board Simplified Block Diagram.
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1.6 FUNCTIONAL DESCRIPTION

The HV9963 device provides all the analog functions necessary to implement a Peak
Current Mode PWM DC-DC Converter. The power train is based on the Boost topology.
The converter provides adjustable constant current at the output, necessary to drive
high-power LED applications. The output (load) current is sensed with a 1.24Q shunt
resistor (Rs). The voltage across this shunt resistor is compared with the reference
voltage at the Iz pin by the HV9963 device’s transconductance amplifier. The
reference voltage for the HV9963 output current is set by the resistor divider formed by
Rrer1 @and Rreg2 The output current is calculated with Equation 1-1

EQUATION 1-1:

| _ VRer

ouUT — 1.24
EQUATION 1-2:

R
REF2
V = x5V
REF
Rrer1 t Rrer2

For continuous conduction mode converters operating in the constant frequency mode,
slope compensation becomes necessary to ensure stability of the peak current mode
controller, if the operating duty cycle is greater than 0.5.

Choosing a slope compensation that is one half of the down slope of the inductor
current ensures that the converter will be stable for all duty cycles.

Slope compensation in the HV9963 can be programmed by one external capacitor
(Cgc) in series with the CS pin. A current proportional to the switching frequency is
sourced out of the CS pin.

EQUATION 1-3:

_ 1
'sc = 26AxTs X 15z

This current flows into the capacitor and produces a ramp voltage across the capacitor.

The voltage at the CS pin is then the sum of the voltage across the capacitor and the
voltage across the current sense resistor, with the voltage across the capacitor
providing the required slope compensation. When the GATE turns off, an internal
pull-down MOSFET discharges the capacitor.

Assuming a down slope of DS (A/us) for the inductor current and a maximum desired
peak inductor current of Igat, the sense resistor can be computed as:

EQUATION 1-4:
Rec = = x(AVyn —0.7V) x 1
CS ™ 12 oo™ (szloﬁxo'g?’ .l
2 xf SAT

DS50002453A-page 14 © 2016 Microchip Technology Inc.
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The slope compensation capacitor is chosen to provide the required amount of slope
compensation needed to maintain stability.

EQUATION 1-5:

Cqc = sc
SC 7 (05 xDSxRsg)

16.1 ENHANCED PWM DIMMING:

The HV9963 has enhanced PWM dimming capability, which allows PWM dimming
widths less than one switching cycle with no drop in the LED current.

The enhanced PWM dimming performance of the HV9963 can be best explained by
considering a typical boost converter circuit without this functionality. When the PWM
dimming pulse becomes very small (less than one switching cycle for a DCM design or
less than five switching cycles for a CCM design), the boost converter is turned off
before the input current can reach its steady state value. This causes the input power
to droop, which is manifested in the output as a droop in the LED current.

The inductor current does not rise enough to trip the CS comparator. This causes the
closed loop amplifier to lose control of the LED current and COMP rails to Vpp.

In the HV9963, however, this problem is overcome by keeping the boost converter ON,
even though the PWM signal has gone to zero to ensure that enough power is delivered
to the output. Thus, the ampilifier still has control over the LED current and the LED
current will be in regulation. See the HV9963 data sheet for more information on
Enhanced PWM Dimming.

1.7 WHAT THE HV9963 BOOST LED DRIVER DEMONSTRATION BOARD
USER'’S GUIDE KIT CONTAINS
The HV9963 Boost LED Driver Demonstration Board User’s Guide includes:

* HV9963 Boost LED Driver Demonstration Board (ADM00650)
* Important Information Sheet

© 2016 Microchip Technology Inc. DS50002453A-page 15
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Chapter 2. Installation and Operation

2.1 GETTING STARTED

The HV9963 Boost LED Driver Demonstration Board is fully assembled and tested.
The board requires the use of an external input voltage source (22V to 26V) and an
external LED load.

2.1.1 Additional Tools Required for Operation

» A DC power supply, a bench supply that can produce 30V and 3A is
recommended to operate the board at the full rated power.

» An oscilloscope and/or a multimeter to observe the waveforms and measure the
electrical parameters (optional).

» A Signal Generator capable of generating a TTL compatible, low-frequency Pulse
waveform with variable pulse widths that can achieve PWM Dimming.

2.2 SETUP PROCEDURE

To operate the HV9963 Boost LED Driver Demonstration Board, the following steps
must be completed:

1. Attach an LED load (or dummy load) to the J2 Output Connector (observe the
polarity).

Connect ajumper between the PWMD input and AVDD of the J3 Input Connector
as shown by the dashed lines in Figure 2-1. To synchronize the switching
frequencies of two or more HV9963 demo boards, connect an external push-pull
waveform source between the terminals PWMD and GND of J3 connector as
shown by the solid lines.

Connect a power supply to the J1 Input Connector (observe the polarity).
To synchronize two or more boards, connect the SYNC pins of all the boards
together. To synchronize the HV9963 Boost LED Driver Demonstration Board to

an external 200 kHz clock, connect the clock between the SYNC and GND pins
of connector J3.

N

B w

Note: During PWM dimming, Pin 2 of the J3 connector should be left open. Also,
the PWM signal must have the proper polarity with the positive connected
to Pin 3 of J3 connector. Note that Pin 4 of J3 is internally connected to the
return path of the input voltage

WARNING

Please observe the polarity for all steps to avoid board damage.

221 Demonstration Board Output Current Configuration

The board is configured to deliver a nominal value of 350 mA to the LEDs’ load. The
maximum output voltage is set to be approximately 75V with overvoltage protection set
at approximately 83V.

© 2016 Microchip Technology Inc. DS50002453A-page 17
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2.2.2 Connecting the Load

A string of LEDs (1W each) can be powered by this board. The LED's string must be
mounted on an appropriate heat sink to keep the maximum junction temperature at
safe level (consult the HV9963 data sheet for details). The nominal current delivered
by the board to the LED's string is set to 350 mA and the maximum output voltage is
75V.

The LED's string can be replaced by a resistor of 220Q and 20W dissipated power
(dummy load). In this case, the power delivered to the load will be about 27W.

Connect the LEDs’ string to the J3 connector. It is very important to use the correct
polarity (see Figure 2-1).

DRA127
101

4 SId4 A
1CH14C

@Mlcnncmp'

£ i

5 -

FIGURE 2-1: Power Supply and Load Connection Diagram.

Note: This board has no Thermal Shut-Down function implemented. Ensure that
the load is properly cooled.

DS50002453A-page 18

© 2016 Microchip Technology Inc.



Installation and Operation

2.2.3

Using the Reference Board

The board has Undervoltage Lock-Out and Overvoltage protections. The thresholds
are 4.7 Vp¢ for AVpp and 83 Vp, respectively.

The board is protected against both No-Load and short circuit conditions.

2.2.4 Connectors
Table 2-1 shows the available connectors on the board.

TABLE 2-1: CONNECTORS DESCRIPTION
Connector Description Pins Connection to PIN
J1 Input Connector VIN Connect the positive end of the input voltage
GND Connect the negative end of the input voltage
J2 Output Connector | LED+ | Connect the Anode of LED string
LED- Connect the Cathode of LED string
J3 Signal Connector GND Connected to negative of input voltage
AVDD | Connected to the AVDD pin of the HV9963 (5V)
PWMD | Connect to AVDD to enable the evaluation board;

connect to a TTL compatible signal to enable
PWM Dimming

© 2016 Microchip Technology Inc.
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2.3 EVALUATING THE HV9963 BOOST LED DRIVER DEMONSTRATION BOARD

The best way to evaluate the HV9963 Boost LED Driver Demonstration Board is to
examine the circuit and measure the voltages and currents with a Digital Voltage Meter
(DVM) and probe the board with an oscilloscope.

Additional tools (current probe, IR camera) are necessary to evaluate some technical
parameters of the board (temperature of power components, ability to withstand surge
voltage pulse on input, EMI).

2.4 DEMONSTRATION BOARD TESTING

1. Normal Operation: Connect the input source and the output LEDs as shown in
the Connection Diagram (Figure 2-1) and enable the board. The LEDs will glow
with a steady intensity.

Connecting an ammeter in series with the LEDs will allow measurement of the
LED Current. The current will be 350 mA +5%.

2. Current Regulation: With the input power to the converter disconnected,
change the LED string voltage within the specifications mentioned.

The output current of the HV9963 will remain very steady over the entire load
range. Vary the input voltage while the circuit is operational. The current will be
regulated over the entire line range (see Figures C-3 and C-4).

3. Open LED Test: Connect a voltmeter across the output terminals of the HV9963.
Start the demo board normally and once the LED current reaches steady state,
unplug one end of the LED string from the demo board.

The output voltage will rise to about 83V and the HV9963 will shut down. Once
the LED string is reconnected, the driver will start regulating current again (see
Figures C-5 and C-6).

4. Short Circuit Test: When the HV9963 is operating in steady state, connect a
jumper across the terminals of the LED string.

Notice that the output current will immediately go to zero and the converter will
shut down. Removing the jumper will cause the HV9963 to restart and continue
to regulate the LED current (see Figures C-7 and C-8).

5. PWM Dimming: With the input voltage to the board disconnected, apply a
TTL-compatible, push-pull square wave signal between PWMD and GND
terminals of J3 connector as shown in the Connection Diagram (Figure 2-1).
Turn the input voltage back on and adjust the duty cycle and/or frequency of the
PWM dimming signal. The output current will track the PWM dimming signal.
Note that, although the converter operates perfectly at 1 kHz PWM dimming
frequency, the widest PWM dimming ratio can be obtained at lower frequencies
like 100 Hz or 200 Hz (see Figures C-9 — C-17).

Some typical voltage and waveforms are provided in Appendix C. “Plots and
Waveforms”.
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Appendix A. Schematic and L ayouts

A.1 INTRODUCTION
This appendix contains the following schematics and layouts for the HV9963 Boost
LED Driver Demonstration Board:
* Board — Schematic
» Board — Top Layer
» Board — Top Silk Layer
» Board — Bottom Layer
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Schematic and Layouts

A.3 BOARD -TOP LAYER

04-10382

A.4 BOARD - TOP SILK LAYER
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A5 BOARD-BOTTOM LAYER
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Appendix B. Bill of Materials (BOM)

TABLE B-1: BILL OF MATERIALS (BOM)
Qty. | Reference Description Manufacturer Part Number
2 C1,C2 2.2 yF, 10% 50V X7R ceramic capacitor | Murata Electronics® GRM31CR71H225KA88L
2 C3,C4 1 uF, 10%, 100V PEN film capacitor Panasonic® ECG ECW-U1105KCV
2 C5,C11 1 nF, 10%, 50V X7R ceramic capacitor | TDK Corporation C2012X7R1H102K
1 C6 220 pF, 5%, 50V COG ceramic capacitor | AVX Corporation 08055A221JAT2A
1 c7 1 uF, 10%, 16V X7R ceramic capacitor | Murata Electronics® GRM21BR71C105KA01L
2 C8, C10 10 nF, 5%, 50V COG ceramic capacitor |Murata Electronics® GRM2195C1H103JA01D
2 C9, C13 33 nF, 5%, 25V COG ceramic capacitor | TDK Corporation C2012C0G1H333J125AA
1 C12 0.1 yF, 10%, 16V X7R ceramic capacitor | Murata Electronics® GRM219R71C104KA01D
1 C14 1 nF, 10%, 50V X7R ceramic capacitor | TDK Corporation C1608X7R1H102K
1 D1 100V, 1A Schottky diode Diodes® Incorporated B1100-13-F
2 J1, J2 2 Position 5 mm pitch header TE Connectivity Ltd. 1546931-2
1 J3 4 Position 2.54 mm pitch header Molex® 22-03-2041
1 L1 100 pH, 2.77A sat, 1.89A rms inductor Eaton DRA127-101-R
1 PCB Printed Circuit Board - HV9963 Boost Microchip 04-10382
LED Driver Demo Board Technology Inc.
1 Q1 100V, 60 mQ, 15 nC N-channel Fairchild Semiconductor® | FDS3692
MOSFET
1 Q2 100V, 350 mQ, 7.5 nC N-channel Fairchild Semiconductor® | FQT7N10TF
MOSFET
1 R1 681K, 1/4W, 1% chip resistor Yageo Corporation RC1206FR-07681KL
1 R2 5, 1/8W, 5% chip resistor Vishay Precision Group Y4015R00000FOW
(VPG)
1 R3 100, 1/10W, 5% chip resistor Yageo Corporation RC0603FR-07100RL
2 R4, R11 10K, 1/8W, 1% chip resistor Yageo Corporation RC0805FR-0710KL
1 R5 0.1, 1/2W, 1% chip resistor Yageo Corporation RL1206FR-7WOR1L
1 R6 33, 1/8W, 5% chip resistor Yageo Corporation RC0805JR-0733RL
1 R7 121K, 1/8W, 1% chip resistor Yageo Corporation RCO0805FR-07121KL
1 R8 1.24, 1/4W, 1% chip resistor Yageo Corporation RC1206FR-071R24L
1 R9 105K, 1/8W, 1% chip resistor Yageo Corporation RCO0805FR-07105KL
1 R10 1K, 1/4W, 5% chip resistor Yageo Corporation RC1206JR-071KL
1 R12 Not Installed/Used
1 R13 300, 1/8W, 5% chip resistor Yageo Corporation RC0805JR-07300RL
1 u2 HV9963NG Microchip Technology Inc. | HY9963NG-G

1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM
used in manufacturing uses all RoHS-compliant components.

© 2016 Microchip Technology Inc.
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NOTES:
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Appendix C. Plots and Wavefor ms

C.1 PLOTS AND WAVEFORMS EXAMPLES
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FIGURE C-1: Efficiency vs. Output Voltage, V,\ = 24V.
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FIGURE C-2: Efficiency vs. Input Voltage, Vot = 72V.
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FIGURE C-3: Change in Output Current from Nominal Value vs. Output
Voltage, V,y = 24V (Nominal Value is the Output Current at Vg = 70V).
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Plots and Waveforms

Cl1 Various Signals During Open LED Protection

Figures C-5 and C-6 show the Hiccup-mode overvoltage protection. When the open
circuit condition occurs, the LED current immediately goes to zero. At that point, the
inductor charges the output capacitor and the COMP voltage is pulled to GND. Once
the output voltage reaches the overvoltage threshold, the converter shuts down and the
output voltage slowly decays because the output capacitor is discharged by the
overvoltage sensing resistor network. Once the output voltage falls to 90% of its trip
point, the converter tries to restart. Since the fault condition still persists, the converter
shuts down almost immediately. Thus, the HV9963 maintains the output voltage in a
band until the LED string reconnects.

‘COMP - :

'‘Qutput Voltage .

: ¢
4 .............................. B
@ 2007 : : TS BT N :
50.0 ¥ €@ 00mh o 1000 points _ 76.0mé
FIGURE C-5: Hiccup Mode Overvoltage Protection.

The figure below shows the recovery of the HV9963 from an overvoltage condition. In
this case, the LED string has reconnected at some point when the converter is turned
off. When the converter attempts to restart, the overvoltage condition is no longer met,
therefore it starts up normally. There is no significant overshoot in the LED current.

CoMP

Output Voltage -~ " - -
B .................................................

4

4 .................................................

& 200V ' ' —J[4.00ms 25.0k5/5 o '

50.0 200m4 Q@ 1000 points 288m#
FIGURE C-6: Recovery From Open-LED Condition.
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C.1.2 Short Circuit Protection

Figure C-7 shows various signals during short circuit protection. The onset of the
output short circuit is indicated by the first spike in the LED current. At this point, the
HV9963 shuts down and the hiccup mode protection takes over. After the hiccup time
ends, the converter attempts to restart and finding the fault condition still present, shuts

down again.
— | I 1

COMP
1 SEES R

OutputVoltage - =
B ...................................................
4 ................................................. +

@ 2.00v ' ' Y L.ooms —100kS/s N '

& coov € 2omik O 1000 points 32.0méb
FIGURE C-7: Short Circuit Protection.

In Figure C-8, the short across the LED string is removed at some point when the
converter is turned off. When the converter attempts to restart, it finds the condition has
disappeared and it starts up normally. There is no overshoot in the LED current.

] |
............... ¢
4 ...................................................
& 200v ' ' Y L.ooms 00K /s Wi
& soov € 2oms @ 1000 points 2.00 ¥
FIGURE C-8: Recovery From Short Circuit Condition.
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Plots and Waveforms

C.13 PWM Dimming Edge Waveforms

Figure C-9 shows various signals during PWM dimming, when PWMD goes low. The
LED current falls to zero with a fall time of about 1 ps.

| [ :
COMP
D T
. QutputVoltage: . . . . . . . . ...l
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: 4
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50.0 ¥ 200md @ 1000 paints 203mé

FIGURE C-9: PWM Dimming at Vot = 54V.

Figure C-10 shows various signals during PWM dimming, when PWMD goes high.The
LED current reaches its final steady state value without any significant overshoot.

@ o0V 40.0ps
& ooy € 00ms @

2.50MS/s @ ]

1000 points 1,32V

FIGURE C-10: PWM Dimming at Vgt = 54V.
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FIGURE C-11: PWM Dimming at Vot = 40V.
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FIGURE C-12: PWM Dimming at Vot = 40V.
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Plots and Waveforms

Cl4 PWM Dimming with Narrow Pulse Widths

Figure C-13 below shows the PWMD dimming input, the GATE drive output and the
LED current for a pulse width of 800 ns (which is less than 1 period of the switching
frequency waveform). As shown in Figure C-13, the GATE drive does not turn off
immediately when the PWMD input goes low. The frequency of the Dimming input is

1 kHz.

By

4 .................................................
@ 500V : : : 1.00ps: oM 6 s
10.0¥ 200m4 Q@ 1000 points 152y

FIGURE C-13: PWM Dimming with PWMD Pulse Width = 800 ns.

Figure C-14 shows the PWMD dimming input, the GATE drive output and the LED
current for a pulse width of 2.5 us (less than one period of fg,,). Also, for this case, the
LED current reaches it’s required value of 350 mA. Dimming input frequency = 1 kHz.
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_F_. 500V : : : ][1.00;5: ~TooMs /s o ] :
@ omt o 1000 points 1,48 ¥
FIGURE C-14: PWM Dimming with PWMD Pulse Width = 2.5 ps.
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FIGURE C-15:
Frequency = 1 kHz.

PWM Dimming with PWMD Pulse Width = 5 ps; Dimming
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FIGURE C-16:
Frequency = 1 kHz.

PWM Dimming with PWMD Pulse Width = 30 ps; Dimming
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FIGURE C-17: PWM Dimming with PWMD Pulse Width = 35 ps; Dimming
Frequency = 200 Hz.
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